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Customer Driven Solutions for Interactive Documents

Team IADS Technical Support

Email:  iads@conus.army.mil

Phone:  (256) 876-IADS

DSN:  (256) 746-IADS

Fax #:  (256) 842-6546

DSN fax:  (256) 788-6546

Mailing Address

Commander:  US Army AMCOM

AMSAM-MSS-LP

Sparkman Center, Building 5301, Room 1122
Redstone Arsenal, Alabama 35898 

Website

https://iads.redstone.army.mil

IADS

IADS (Interactive Authoring Display System) is an Army funded project originally developed to help reduce paper documentation through creating and distributing technical manuals in electronic format, IETM (Interactive Electronic Technical Manual).  IADS utilizes XML (Extensible Markup Language) or SGML (Standard Generalized Markup Language) to manipulate text and graphics.

**Images reported in this document are for reference only and therefore may display differently on each computer due to resolution, display properties, or operating systems.

IADS READER

The Reader software is designed to display the final document to the end-user.  The user accesses information through menu or button commands or through hotspots (hypertext links) by using the mouse or keyboard inputs.

IADS Reader Screen Layout
The Screen Layout section serves to identify the different parts of the IADS Reader screen such as the blue bar at the top of the window, the available menus, the default buttons, the display area, and the gray bar at the bottom of the application.  Within each section, the features are described in detail along with applicable instructions.  The IADS application window (below) is divided into seven distinct areas:  Main Window BarIADSREAD.MWB001, Menu BarIADSREAD.MB_001, Control Panel ButtonsIADSREAD.CPB002, Display AreaIADSREAD.DA_002, Navigation Pane, and Status BarIADSREAD.SB_001.
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Software, Training, and Contact Information

1ADS was originally developed to eliminate the need for paper technical manuals in the field. It also eliminates the need for paper documentation, drasticaly reduces storage problems,
increases speed and accuracy for updates, reduces print costs, and enhances search and retrieval times. Combine all this with its intuitive user interface, and IADS is a winner in the
Electronic Documentation arena.

This demonstration fil is designed to orient the user with IADS software information as well as the application capabiliies. The first section details the benefis of utlizing IADS and lists
training and contact information. The second section provides highiights of IADS software features





Main Window Bar
The Main Window bar appears at the top of the window and displays the title of the current document.  When the IADS application is minimized, the document title will appear beside the IADS icon in the status bar at the bottom of the screen.
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Menu Bar

The IADS Reader application Menu Bar has menus that assist the user in opening files, traversing, book marking, notating, and searching within IADS documents to name a few features.  The right side of the Menu Bar defines the user currently logged in.  Clicking on the user name reveals the Users ParametersIADSREAD.SUP002 dialog where user settings may be changed.  The Menu Bar (below) is divided into five distinct areas:  File Menu, Movement, Menu, Tools Menu, Options Menu, Help Menu.
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Control Panel Buttons

Control Panel Buttons give easy access to common IADS functions.  A set of default buttons are available for navigation, help, notation, book marking, printing, reporting, searching, and exiting.  When selected with the left-mouse button, the control panel button performs a function.

[image: image5.jpg]< Back

P ENY &SI

[l

3 %





Frame Title Bar
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Display Area

The Display Area contains the text and graphics of the current frame and is usually the largest part of the IADS application window.  There is a basic display and a split screen display area.
Basic Display

The Basic Display of an IADS Reader window is as follows with a single window containing text, embedded graphicsIADSREAD.G__002, tables, hotspotsIADSREAD.H__002, or any combination of these features.
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Software, Training, and Contact Information

1ADS was originally developed to eliminate the need for paper technical manuals in the field. It also eliminates the need for paper documentation, drasticaly reduces storage problems,
increases speed and accuracy for updates, reduces print costs, and enhances search and retrieval times. Combine all this with its intuitive user interface, and IADS is a winner in the
Electronic Documentation arena.

This demonstration fil is designed to orient the user with IADS software information as well as the application capabiliies. The first section details the benefis of utlizing IADS and lists
training and contact information. The second section provides highiights of IADS software features





Split Screen

A document author may design images to appear in Split Screen mode rather than embedding IADSREAD.G__002them within the text.  If a frame opens in split screen, as seen below, the document author may also define additional hotspot references within the text to refresh the Split Screen pane.

The blue bar extending the top of the graphic display is the Graphic Title Bar where the title of the graphic is displayed.  The blue bar extending the top of the text display is the Frame Title Bar where the title of the frame is displayed (along with the frame number if the author has set this feature).
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Helicopter & Humvee (1 of 2)

Splt Screen (33 of 41]

B-Split Screen =

Graphics directly related to a frame of text are often displayed in split screen mode (defined

by dourent a1 a s n i fame. Th grapic g contans  toobar
2| @[ %] %] for navigating between next and previous graphic sheets.

Figure 1.Helicopter and Humvee
Sheet (1 0f2)
Sheet (2 0f2)

While a split screen image is in view, selecting a hotspot that references a graphic
refreshes the split screen with the newly selected graphic.

To refresh the frame vith the default split screen image, select Options > Reset page
image to default.

Camera lcon @i (Upper Right Corner of This Pane)
« Afiliates the current frame with an image

+ Used to toggle split screen on and off

« Appears on all frames with spiit screen definitions

+ Remains "off"for allfames during the current IADS session once i's toggled off
+ Always retuns to the default mode "on” when re-entering IADS

Split Screen Features
+ Zoom 9

« pan 2]

+ Select hotspots (green boxes)

Split Screen Options (Right Click Graphic)
+ View maximized

+ View image information
+ Create rediines

+ Print image

TCarrent frame: 33 of &1

|C\ProgramDatalADS\DENO3 AFILES\demo ximl

3.4.0003




How to Toggle Split Screen On/Off

If displaying the textual information in full screen view is necessary, the split screen function may be temporarily disabled by selecting the camera icon hovering over the upper right corner of the right window. When split screen is turned off, it will remain off for the current IADS session or until the camera icon is re-selected. This button toggles the split screen on and off.  The camera icon changes according to the mode in view.
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Select to hide Split Screen Image
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Select to show Split Screen Image
NOTE:  When split screen is turned off, it will remain off for that frame until the camera icon is either selected again or the file is exited and reentered.

Image Toolbar Features

The Image Toolbar hovering over the lower right corner of the left window provides functions related to the displayed image.  The functions include Next and Previous image (for graphics with multiple sheets), Print, Save, Zoom, Pan, and Hide Toolbar.
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Status Bar

The Status Bar appears at the bottom of the application window and displays Alert references and Notes IADSREAD.N__004associated with the current frame, information about items the mouse is hovering over, the current file location, and the current version and build of IADS that is running.
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NOTE:  Alerts and Notes may be reviewed by clicking the alert in this bar.
How to Navigate
Shortcut Keys

Common IADS functions are accessed through the menus or the control panel.  Shortcut Keys are provided for those who wish to use keyboard-traversal.  This section lists IADS commands and their associated Shortcut Keys.

	Shortcut Keys
	Command

	Ctrl+b
	History

	Ctrl+n
	Notes

	Esc
	Exit

	Home
	Go to the First Frame in the document

	End
	Go to the Last Frame in the document

	F1
	IADS Help

	Right Arrow
	Next Frame

	Left Arrow
	Previous Frame

	Ctrl+p
	Print Frame

	Ctrl+r
	Report Errors

	Ctrl+h
	TM Help (See Help IADSREAD.H__006button)

	Right mouse click 
	Back or Forward in history or a shortcut menu.IADSREAD.I__001

	Down Arrow
	Scroll Down

	PgDn
	Scroll Page Down

	PgUp
	Scroll Page Up

	Up Arrow
	Scroll Up

	Ctrl+s
	Search

	
	


Mouse Clicking
The Interface section provides options for the use of a Right mouse click.
Right mouse click will show navigation menu provides a menu to traverse between frames.  The default is Right mouse click shows navigation menu however users have the option to “step back in history list”.  This can be changed by clicking Options Menu/Set User Parameters and clicking the MISC tab.
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Movement Menu

The Movement Menu provides functions to assist in traversing the document and going to specific frames.
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Goto Frame/IDRef

Selecting Goto Frame/IDref displays the Select IDREF dialog which displays a list of all frames in the current document.  Highlighting a frame and double left clicking quickly, highlighting a frame and pressing <Goto>, or entering the frame number in text box and pressing <Goto>, all navigate to the selected frame.  
There is an option to Sort list by: Frame title, Frame ID, or Occurrence in file.  If the document author has not specified Frame titles, only the Frame IDs will be listed (and will appear twice as they fill the title placement).  Current frame: in the upper left corner identifies the current frame number out of the total frames in the file.
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Navigation Pane

Selecting Navigation Pane will display the Table of Contents (when available), Bookmarks, User notes, History, or Search panes.  To view all the contents horizontally, place the cursor over the narrow blue line until it turns in to double sided arrow.  Left click the mouse and drag right. The scrollbar will appear if contents are available vertically.  Click X to disable pane.
**NOTE:  Only one content pane will display at a time.  For example, viewing the History Pane and then selecting Bookmark Pane will replace the History Pane. 
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Table of Contents Window Pane (When Available)

The navigation pane on the left side of the picture below represents a Table of Contents Pane which may be used for frame navigation.  
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B-IADS Programs

When downloaded from the intemet, IADS is installed directly to your hard drive. It contains all of the programs needed to author and read an IET. The picture
below displays all the programs that are installed during a full program installation, as well as the programs that are exclusive to the reader only.

h @

IADS Author  IADS Config  IADS Help

o

IQReader  LinkVerifier  Parameter RPSTL. Uninstall
Admin Author 1ADS





Show Document TOC Pane Button is located in the Control Panel Buttons (shortcut icon displayed in the top gray bar).  To deactivate, click the panes close button (X). To view all the contents horizontally, place the cursor over the narrow blue line until it turns in to a double sided arrow.  Left click the mouse and drag right.  The scrollbar will appear if contents are available vertically.  If the Index at the file level or at the frame level is not associated with a file, the Index button on the tool bar becomes an on/off switch for the TOC pane.  Click X to disable pane.
NOTE:  The Table of Contents Pane is created by the author and will only be available if it has been authored to display.

History

Selecting the History IADSREAD.H__007button displays the IADS History List window pane.  This displays the list of IADS frames (T:), RPSTL items (R:), and graphics (G:) visited since the start of the current session.  By clicking on an item, the displays navigate to the selected item.  Click X to disable pane.
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How to Search

This utility is used to locate text in a frame, file, a collection of files, or a collection of manuals.
This function is found on the Control Panel Buttons (shortcut icon displayed in the top gray bar).  Click the tabs to toggle between search panes. Each pane will retain its search when toggling.  This search provides three types of capabilities:

Text Tab: Opens the IADS Search Window Pane for all searches seeking a specific word or phrase. IADSREAD.S__003
RPSTL Tab: Opens the RPSTL Search Window Pane for all searches seeking information found in a RPSTL.
IQuest Tab: Opens the IQuest Search Window Pane to find task-based information found in the manual or RPSTL.
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NOTE:  The Search Pane is created by the author and will only be available if it has been authored to display.

How to create Bookmarks

Bookmarks are created by clicking the Bookmarks Button then <Add> in the Bookmarks Pane. The dialog box will provide the frame title.  If the document author has not specified Frame titles, only the Frame IDs will be provided.  A different description can be added in the text box.  These are stored by user login and, therefore are only available when logged in as the same user. Click X to disable pane.
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How to create Notes

Notes can be created either by clicking the Access Public and Private Notes Button on the Control Panel Buttons then <Add> in the Notes Pane.  Selecting <Edit> displays the User Defined Notes dialog.  This stores all the notes created on the current machine for IADS Reader/Author.  The user can create, modify, remove, print, view, list, import and export notes.  Left mouse click X to disable pane.
** Notes are kept in the following path C:\Documents and Settings\All Users\Application Data\IADS\Notes
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How to create an Error Report
Report Errors are created by clicking the Submit a DA 2028 Report Error Button on the Control Panel Buttons.  This tool is designed for reporting errors in the technical manual.  It contains fields for capturing all the necessary 2028 information and emails the report directly to the receiving personnel for processing. Selecting Submit a DA 2028 Report Error ButtonIADSREA displays the IADS Electronic DA-2028 dialog.  
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How to Change User Settings

Set User Parameters allows the user to set preferences based on login.  Most user preferences are saved in registry.  Default document, toolbar location, background color and text editor are just a few settings that can be made through User’s Parameters.  This function can be found in the Options menu.
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Change default document (Select a New File)

This is the file that will display when logged in as a user.

· Click Options menu\Set User Parameters.

· Click the “Select file” button under Default document file and browse for the new default file.

· Click the “OK” button.

· When the user logs into IADS again, this new document selected will be the default document.

Change default document (select the File currently loaded)

The file is currently opened will display when logged in as a user.

· Click Options menu\Set User Parameters.

· Click the “Use current file” button.

· Click the “OK” button.

When the user logs back IADS again, this new document selected will be the default document.

Other Commonly sought User Parameter Settings

Defaults Tab:
· Include summary info on printed pages

· Save/restore window position and size
· Show hotspots on images

· Hide scrollbar when not needed
· Show tooltip prompts for control panel buttons
· Allow multiple IADS instances – this setting allows the user to open multiple instances of an IETM, this setting can be useful for authors and users.  An author might use this setting to open a new and an older version of an IETM for comparison or QA.  A user might use this setting to allow multiple users to open individual instances of an IETM on a single computer, one user may need to access maintenance procedures while another needs to access the RPSTL database, by allowing multiple instances of IADS the users can work from a single computer without disturbing the other users location within the IETM.

RPSTL Display

When a RPSTL is accessed by the user, IADS displays the figure and RPSTL data in split screen fashion.  The Table of Contents updates to reflect the RPSTL in view.  
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RPSTL Search

This utility searches a specified RPSTL for the requested data.  The matching records display in the SEARCH RESULTS within the frame.  

 
Select RPSTL - Use the list box to select a RPSTL to search upon.  The last RPSTL reviewed will appear by default.

Search on - Select from this drop down list to specify what value type to conduct the search on.  The user may search on any data field defined for the RPSTL, including dynamic data.  The type of search selected will dictate the other screen controls available to the user.  If Figure,Item is selected a dropdown text box will become available for Figure and Item.  Every other search type will evoke the Type in the word to find text box and selection box.

Figure and Item - When a Figure, Item search is selected from Search on, a dropdown text box becomes available for selecting the Figure and Item you want to search upon.  The Figure and Item can be typed or selected from the list of values.  Each time a different figure is selected, the item list is reset to reflect the valid range of items for the new figure.  You may search on a figure without selecting an item.  In this case, all items for the figure are selected with the first item initially displayed.

Type in the word to find - This text field is available for all search types except Figure, Item and sometimes Description.  Type the key value to search on in the Type in the word to find text box.  Wild Cards are not accepted.  As you type, the list box scrolls to display the first matching value in the list.  The text box is also populated when an item is selected in the Values Within Range list box.

 

NOTE: When NIIN is selected from Search, the last 11 digits of the NSN appear for selection, instead of all 16.

Search Mode - This drop down list is available for all search types except Figure, Item and NIIN.  Use them to place limits on the search criteria.  The Starts With, Ends With and Contains radio buttons are ways to circumvent the limitations on Wild Cards.  A Null value search will locate records that do not have a defined value for the selected data type. Exact Match is the default search mode for all search types except Description, which defaults to Contains.

Skip to first item with UOC - When supplying the results, the results will be ordered to display records with the selected UOC shown first.

Search - After typing the criteria to use for the search, press <Search> to conduct the search.  The results of the search will be displayed directly in the frame.

Show previous results - This feature is disabled for RPSTL Searches.

Search Results

Displays information regarding the current RPSTL search.  The earliest matching figure and item reference is always displayed first as record one.  The frame summarizes the figure and part data for all search records.

Criteria - Made up of 3 parts...

· Search on:  The type of value which is being compared to the search key

· Search Mode:  How the search key is being compared with the search type

· Search Key:  The value that is being searched for.  It may be a complete or partial value depending upon the search mode.

Record - Returns the number of records found that match the search performed.

· Previous [image: image27.png]


button:  Displays the previous record.  If it is already at the first record, it will cycle around to the last record.

· Next [image: image28.png]


button:  Displays the next record.  If it is already at the last record, it will cycle around to the first record.

· Select:  Displays the Select Search Record allowing you to choose a specific record to view.  If only one record is available this hyperlink will not display.

Group Data

· FGN - Functional Group Number of the functional group depicted in the figure.  
· Group Desc - Description of the functional group depicted in the figure, and other pertinent information.
· Group NHA - Identifies the group that is the Next Higher Assembly of the current Functional Group.

Item Data - Displays information regarding the selected item.  The exact elements shown and the order in which they appear can vary for each RPSTL.  In a RPSTL document, each data element can be given a special action.  Double clicking that data element causes the action to be performed using the item value currently assigned to the element.  If no custom action has been specified, the value is copied to the clipboard.

 

Figure/Sheet Data - Displays information and options related to the current figure.  The title of this section changes to display the current figure shown. 

· Item on Sheets - Indicates every sheet in the figure that contains the current item.  To display a sheet in this list, click on the sheet number.

· Sheets - Displays the number of sheets that make up the current figure and lists the sheet currently being shown out of the total sheets in the figure.

· Previous [image: image29.png]


button: Displays the previous sheet in the figure to be displayed.  If it is already at the first sheet, it will cycle around to the last sheet.

· Next [image: image30.png]


button: Displays the next sheet in the figure to be displayed.  If it is already at the last sheet, it will cycle around to the first sheet.

· Select:  Displays the Select a Sheet dialog allowing you to choose a specific sheet to view. This allows you to easily select a sheet to view.  Select the desired sheet and press <Go To>.  IADS will navigate to the desired sheet and display its corresponding data.
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RPSTL Pop Up Window

Document authors may create RPSTL hotspots with a pop up summary window.  If this feature has been included, the part's information may be viewed quickly in this pop up window.  Buttons are available for navigating through multiple parts, adding a part to the shopping cart, and displaying the part in full RPSTL view.
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Add Item to Shopping Cart

Selecting Add Item to Shopping Cart from the Toolbar or from the RPSTL Menu displays the Add Item to Shopping Cart which places the currently selected item into the Shopping Cart.  If a custom order parts interface has been created, the Add Item to Shopping Cart dialog will appear.  This allows the user to enter more information about the part they are ordering.  If a custom parts interface has not been created a confirmation will appear that the part has been placed in to the shopping cart and the user may utilize the Export feature.
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Parts List

All the parts that the user has added to the shopping cart appear in this table.  Selection of a part from this table enables actions such as removing a part or viewing a parts details.

Fields Within the Part Information Section

Fig,Item - Displays the Figure and Item # of the selected part.

Part Details - Press this button to launch the Part Details (Dialog).

Remove Part - To remove a part from the list, select the desired part from the parts list and press this button.  You will be asked to confirm this deletion.

After selecting parts to order this will allow the user to review the parts they have selected, modify their selections, and order the parts.
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The parts list may be exported to a file for ordering or other logging purposes.  The options available are:  Text File, Delimited File, XML File.  The option, Request Parts, is the default selection which enables the order quantity of a selected part to be modified.

 

Request Parts:  To change the quantity, select the desired part from the parts list, set Action: Request Parts.  Then, either type a new quantity in the Order Qty field or use the up and down arrows to increase or decrease the number, and select <Save Changes>.  The quantity field in the parts list will update with the modified information.
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Export to Text File:  This option creates a text file according to a pre-determined layout.  Type the path and file name to store the exported part information and press the <Export Parts> button to create the text file.
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Export to Delimited File:  This option allows the user to select the character used to delimit or separate the data values stored in the file.  Type the path and file name (or use the <...> button to select a location) to store the exported part information.  The user may select any character to be the delimiter.  To use the Tab character, type the value “^t”.  Then press the <Export Parts> button to create the delimited file.
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Export to XML File:  This option creates an XML tagged text file with pre-determined tags describing the content.  Type the path and file name (or use the <...> button to select a location) to store the exported part information.  Once selected, press the <Export Parts> button to create the XML file.
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Clear Part List Upon Successful Order

This option is selected by default and will clear the part list if <Export All Parts> is pressed and successfully passes the information to the designated program.  Deselect if you do not want the parts removed from the list once an order/export has been completed.

Request Parts/Export Parts

The label will change on this button depending on the selection made under Action.  After reviewing the parts selected for exportation, press this button to create the parts file as selected under Action.

Clear Cart

Press this button to clear all the parts from this list.  You will be prompted to confirm this decision before the items will be deleted.

PRINTING from the IETM

The user has the option to either print a screen shot through Print Current View or print the entire frame content of one or multiple frames through Print Frame.  

· IADS Author /File /Print Frame
· IADS Author /File/Print Current View
· Within IADS the print icon [image: image40.png]


 invokes Print Frame (not Print Current View)
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· Print to File - Saves information to a file rather than printing.

· Include graphics within document content - Prints embedded graphics.  De-selecting this option may be helpful when only text is needed, for quicker printing, or limiting the amount of paper used to print.

· Start each frame on a separate page - Deselect this option of you want to have each frame print continuously rather than start on a new page.  When printing a series of short frames it may be helpful to allow continuous printing rather than each frame on its own page.

· Print 'split-screen' graphics with each frame - Select this option to print split screen graphics along with the textual information.

· Print Range - To print just the frame in view select Current frame.
· To print multiple frames within the file or a different frame from the one currently displayed, Choose frames and press <Select frames>.  This brings up a dialog that displays all the frames within the current file.  To print multiple frames press Ctrl and click each frame entry desired.  Clicking the column headers sorts the entries chronologically or alphabetically.
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· Print - Once all printing preferences have been chosen press this button to send the request to the printer.

NOTE:  When selecting the Print button from the tools bar or File/Print/Print Screen, the option to select multiple frames is disabled.

Create Tearoff

This tool copies the entire textual frame as a screen capture for options utilized within the View Tearoff feature.  Selecting this option from the menu captures the current frame (text side only).  To perform features such as saving the capture as a JPG, open the View Tearoff dialog.  IADS Author /Tools/Create Tearoff
 View Tearoffs 

This tool allows you to view, copy, delete, and save screen captures which are created through the Create Tearoff option.  IADS Author /Tools/View Tearoffs 

· Save as - Saves the selected tear off as a JPG to the location you choose.

· Copy - Copies the selected tear off to the clipboard so you may paste it in to a program of your choosing.

· Delete - To delete one tear off, select it from the list and press this button.

Copy Frame Text to Clipboard

Selecting Copy frame text to Clipboard from the Tools Menu copies the text from the current frame to the system’s clipboard.  This text can then be placed in other documents through the commonly used "paste" methods.

Restore Saved History and Responses

Selecting Exit terminates the current IADS session and offers the option of saving history and user responses for selection later.
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If <Yes> is selected, the users history is automatically saved.  Also, if responses have been recorded, a response file can be saved by the user.

 

If <No> is selected, the IADS session will terminate without saving history or responses.

Selecting Restore saved history and responses from the IADS TOOLS Menu, allows the user to restore their last saved history list and response file.  When selected, an information box notifies the user of the history list restoration, Select OK.  User will then be prompted to restore a response file, Selecting <Yes> allows the user to select a response file to restore.  Select <NO> if there are no responses files to restore.  IADS will then navigate to the last location where the user previously exited the document.
Hotspots

A Hotspot is a region in the display area that the document author has linked to other information.  Hotspots can be made to stand out by using different fonts, font colors, or font style.  This Interactive Electronic Technical Manual (IETM) uses hotspots to link to other procedures, lists, movies and RPSTLs. Hotspots are displayed in bold blue. When the cursor turns to a pointing hand, click the left mouse button.
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Alerts

Warnings, Cautions and Notes are provided immediately before related procedures.

Warnings and cautions may have an OK button. The OK button must be clicked before continuing through the frame.  Click on the OK button after message has been read.  
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IADS installation
You must have FULL ADMINISTRATOR rights on your computer to install this software.  If you do not have administrator rights, contact your administrator.  This CD-ROM contains the program files and data necessary to install and access the IETM.  If the CD-ROM drive on the computer is set for AUTO INSERT NOTIFICATION, the IETM installation will start automatically.  If the CD-ROM has AUTO INSERT NOTIFICATION turned off, you can start the installation process by executing the file SETUP.EXE on the CD-ROM. 

The install program allows two methods of installing the IETM:
· Compact Setup -  All programs and data are accessed from the CD-ROM (also suitable for network setup -- see note below).
· NOTE FOR NETWORK ADMINISTRATORS – 
· To setup over a network (LAN):
1. Copy contents of this CD (including the file "setup.exe") to the destination location on the network server.
2. Provide the user with access to the setup program which they can then run on their computer in order to complete the network setup of the IETM.  This can be done by having the user browse to the location of the setup program on the shared network drive or by providing the user with a shortcut to the setup program.
3. User should select the Compact Setup option during the installation routine.

· Hard Drive Setup - All programs and data are installed to the hard drive.
Tool bar navigation buttons 
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Indicates there is a history item available. Selecting this button will navigate the user back one step in the history list. If the word Back is greyed out, the indication for the user is that the user is at the beginning of the history list. There are no history items to return to. Works like the back feature in internet explorer.
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Selecting this button opens the IADS History List dialog box.
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Selecting the Forward button, when active, will navigate the user one step forward in this history list. Works like the forward feature in internet explorer.

· Selecting  Ctrl+Home will navigate to the first frame of the work package

· Selecting  Ctrl+End will navigate to the last frame of the work package
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Selecting the Previous button to traverse to the previously viewed frame. If there is no previous frame defined, this button will be greyed out.  Navigates frame by frame through the work packages.
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Select the Next button to view the frame that follows the current frame. If there is no next frame defined, this button will be greyed out.  Navigates frame by frame through the work packages.
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Selecting this button opens the IADS History List dialog box.
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Selecting this button displays the Table of Contents in the Navigation Pane, which is located at the left section of the frame.
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Selecting the Report Errors button gives the user the ability to display the Electronic DA Form 2028, Recommended Changes to Publications and Blank Forms form within a dialog box for reporting errors found within the document.
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Selecting this button displays the Search Options in the Navigation Pane. This function gives the user the ability to search by text in the entire document frame or file. Another tab gives the user the ability to search the RPSTL.
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Selecting this button displays the IADS Print dialog box and allows for the printing of frame(s).  
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1. In reference to the blue highlighted box – the user may choose to include graphics within the document content, start each frame on a separate page, and to print the split screen graphics associated with each frame.

2.  In reference to the red highlighted box - the user has the option to print a single current frame or select additional frames from the work package. The select frame option allows the user to print the entire work package and example of this utility is below.
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Selecting this button terminates the current IADS session and offers the option of saving history and user responses for selection later.
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Selecting this button displays the User Defined Notes dialog box. This dialog box stores all notes created on the current machine. The user can create, modify, remove, print, view, and list notes.
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Selecting this button displays a Bookmark dialog box providing the user the ability to place bookmarks in the current document. These are stored by the user login and are only available when logged in as the user that created the bookmark.
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Selecting this button displays the document index, if one is available. 
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This is a hotspot return button that becomes available when a hotspot has been selected that is authored for this feature. When it is available, pressing this button returns the user to the last location.
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Selection of this button displays the help information associated with the current document or frame. If a help document is not available, an error message displays.
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This button only appears when the RPSTL is in view. A parts ordering interface must be available for this button to appear. If there is no parts ordering functionality, this button will not appear. Selecting this button places the currently selected item into the shopping cart for future ordering or exporting. If a custom ordering system has been set up for the user, the user will be prompted to enter more information about the order.
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This button only appears when the RPSTL is in view. A parts ordering interface must be available for this button to appear. If there is no parts ordering functionality, this button will not appear. Selecting this button displays the Order Parts dialog box. If a custom part ordering interface has not been created, this option will be unavailable.
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This button only appears when a RPSTL item is view. Selecting this button will take the user to the appropriate RPSTL section for ordering. If a custom part ordering interface has not been created, this function will be unavailable.

